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Introduction 
This user guide describes the functionality of the AliveDrive Desktop v2.0 application available for macOS. 
The application enables owners of vehicles equipped with Cosworth’s AliveDrive system to view and analyse 
their outing recordings outside the vehicle, and provides a way to share the content with others. 

What vehicles are supported? 

In release v2.0, recordings from vehicles equipped with ALL variants of the Performance Data Recorder (PDR) 
are supported: 
 
First-generation PDR, also known as PDR1: 

• Corvette C7 2015 to year 2019 
• Chevrolet Camaro 2017 to 2024 
• Cadillac ATS-V and CTS-V 2016 to 2019 

 
Second-generation PDR, also known as PDR2: 

• Corvette C8 2020 to year 2025 
• Cadillac CT4 and CT5 2022 to 2025 

 
The third-generation, Enhanced PDR (a.k.a. PDR 2.5) is available on the following models: 

• Corvette C8 2026 and onwards 
• Cadillac CT5 2025 and onwards 

 

Getting Started 

Download and Member Portal 

The AliveDrive Desktop application is available for download via the Cosworth Member Portal. The portal, 
accessible via the main Cosworth homepage, is your gateway to the latest in software available from 
Cosworth. Here you can download and subscribe to Cosworth’s data analysis applications, access product 
updates, software releases, and technical documentation, and stay informed with the latest development 
news. The Portal also provides a central location for support, ensuring you always have the tools and 
information needed to extract maximum performance from your Cosworth-equipped vehicle systems. 
 

 
Figure 1 - Cosworth Member Portal 

https://members.cosworth.com/
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Once access to the portal is set up, the application download is available from the AliveDrive Desktop 
product page. The application can be downloaded for both Windows and macOS via dedicated download 
buttons. 
 

Installation 

The macOS application is designed and tested for deployment on macOS Sequoia and Tahoe target 
machines. The installer provides guidance on the installation steps. 
 

Licensing Agreement 

The licensing agreement is presented during the installation; acceptance is required in order to proceed to 
use the application. The installation of a licence key is not required, and the application does not require a 
payment for use. 

 
Figure 2 - Licence Agreement 

 
Acceptance of the agreement is only required for the initial installation, and when the licensing terms get 
updated. Re-acceptance is not required each time the application is loaded or when the application is 
updated.  
 
The Licensing Agreement is available here should reference to it be required at a later date. 
 
 

  

https://www.cosworth.com/motorsport/support/alivedrive-data-analysis-tools/alivedrive-desktop-licence/
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Application Navigation and User Interface 

 
Figure 3 – Application Launch 

 
The main menu provides centralized navigation for outing selection, playback, export, and application 
settings/information. A link to the help resources is also available via the menu. 
 
Once an outing is opened, playback controls for play, pause and skip are provided via a scrubber bar., and a 
lap breakdown and lap selector is shown: time per lap, indicators for fastest and selected laps. 

Mouse Controls 

Mouse actions are used for the majority of menu selection and button control of the application. In addition, 
a mouse drag-and-drop can be used, refer to section File Management and Outing Operations. 

Keyboard Shortcuts 

Shortcut Description 
Cmd+O File > Open Outing 
Cmd+W File > Close Outing 
Spacebar Control of play/pause function during playback 
Cmd+P Play 
Opt+Cmd+ Step forward 10s during playback 
Opt+Cmd+ Step backward 10s during playback 
Cmd+ Go to Previous Lap 
Cmd+ Go to Next Lap 
Opt+Cmd+ Mute audio 
Shift+Cmd+E Export outing 
Fn+F Enter Fullscreen mode 
Cmd+M Minimise window 
Fn+Ctrl+F Fill available space with playback window 
Fn_Ctrl+C Centre the window 
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Settings 

The app has its own settings for speed, distance, time format and temperature units with three options: 
• UK 
• Metric 
• US Customary 

 
The app will default to the location based on the regional settings of the device hosting the app, but this 
default can be over-ridden via the menu. 
 
Speed and distance values displayed within the app including those displayed on the outing overlays are 
adjusted according to the chosen setting. 
 

Audio 

The on/off control of audio playback is provided in the playback bar. The application utilises the device 
settings for choice of audio output device and volume.  



 

7 
 

File Management and Outing Operations 
The outing files from the vehicle need to be copied from the SD card to a suitable device folder or personal 
cloud storage area. 

Outing types supported 

All types of outing can be opened for playback and export – circuit, autocross and dashcam.  
 
Outings recorded with any generation of PDR (PDR1, PDR2 or PDR 2.5) system are supported.  
 
Free choice of outing for comparison can be made in dual-video mode. For example, a PDR2 outing can be 
compared with a PDR 2.5 outing. 
 
Outings can be opened via the menu , via keyboard shortcut (CMD+O), via a right-click action within the 
window, or via a drag and drop action into the application window.  

Open via menu 

 

Figure 4 - Opening an outing using the menu 

 
Figure 5 - Attempt to open an un-supported outing file 
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Switching to another outing via the menu 

To switch between outings using the menu, first close the original outing then open the new outing. 
 

Adding a Reference outing via the menu 

Opening a second outing via the menu without first closing the existing outing has the effect of opening the 
second outing as a reference outing for comparison. 
 

Right-click to open 

 
Figure 6 - Right-click to open outing 
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Drag and Drop 

When the application is first opened, and an outing has not yet been selected, an outing can be selected 
using the Finder application and dropped within the Application Window to open it.  
 
In addition, drag&drop can be used to open a second outing whilst an outing is already open. 
 
There are two variants of this procedure, based on where the file gets dropped in the application window: 

• Open an outing that replaces the Current outing, remain in single-video mode 
• Open an outing that becomes the Reference outing, view changes to dual-video mode 

 
The dotted-line border around the current outing (Explorer Bar and outing video panel) as shown in Figure 8 
below indicates the drag&drop zone to effect the action. 

 
Figure 7 - Drag&drop new outing onto existing outing to replace it 

 
Figure 8 - Drag&drop new outing outside the dotted-line areas to add the outing as a Reference 
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Opening an outing whilst two outings are already open 

When an outing is opened either via the menu or via drag&drop and two outings are already open, there is a 
choice given as to which outing should be replaced with the new one. 

 
Figure 9 - Prompt to choose outing for replacement when menu used for opening new outing 

 
Figure 10 - Drag&drop zones provide choice of which outing to replace 

 
 
A further way to open outings is via the Explorer Bar, as described below.  
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Explorer Bar description and use 

 
Figure 11 - Explorer Bar showing two outings 

The Explorer Bar is the area above the video panel where the lap times are displayed. It is separated 
horizontally into zones to allow right-click actions with the mouse to act upon either the Current Outing (top 
row of Explorer Bar) or Reference Outing (bottom row of Explorer Bar). 
 
The Explorer Bar makes use of colour coding to indicate the chosen lap or laps from the Current Outing, and 
the chosen Reference Lap. The Outing Fastest Lap indicates the fastest recorded lap within the Current 
Outing. The Overall Fastest Lap indicates the fastest lap for the two outings loaded. 
 
In addition to displaying the lap choices and data, the Explorer Bar can also be used as a way to choose 
outings, and toggle from single to dual mode, as described below. 
 

Opening outings using the Explorer Bar 

Once an initial outing has been opened, the Explorer Bar can be used to choose alternative or additional 
(reference) outings. 
 

Right-click on current outing 

With a right-click within the Current Outing zone (anywhere in the top row), the already open outing can be 
replaced, and the view will remain in the single-video mode. 

 
Figure 12 - Right-click on the currently open outing 

 
Additionally, choosing the “Use as Reference” option as shown in Figure 12 above will toggle the display to 
dual-video mode. The current outing will be used as both Current and Reference outings, which facilitates a 
comparison of laps within the same outing. 
 
The “Clear Selection” choice will clear the currently chosen lap within the outing. 
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Right-click beneath current outing 

With a right-click within the zone beneath the current outing (anywhere but the top row), a second outing 
can be opened as a reference outing. The view switches to dual-video (comparison) mode). Figure 13 shows 
the menu that appears for the right mouse click action within this area. 
 

 
Figure 13 - Right-click beneath the currently open outing 

 

Swap the Current and Reference 

 
When two outings are open (Current and Reference), their position can be swapped using a right-click action. 
With a right-click of the Current outing, and choosing the “Use as Reference” option, the Current outing will 
become the Reference, and the Reference outing will become the Current. 
 

 
Figure 14 - Right-click on Current outing to toggle position of Current and Reference 
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Outing Properties Sidebar 
 

 

 
 

Figure 15 - Outing Properties sidebar – single and dual-video modes 

 
The outing properties sidebar provides information taken from the outing file for each open outing.  
 
 
 

 
Figure 16 - Outing Properties control buttons 

 
The sidebar control buttons can be used to fully open/close the sidebar and to expand chosen details for all 
open outings. 
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Single Outing Playback 
With a single outing file loaded, the outing video is presented along with outing properties (name, date, time, 
vehicle make/model) and a breakdown of the outing into laps (for circuit outings). By default, for a circuit 
outing, the playback position will be set to the beginning of the fastest lap within the outing. For autocross 
and dashcam outings, the outing will open with the lap selector showing a single lap – this ‘lap’ being the 
whole outing. 
 
The overlay toggle button can be used to switch between any available overlay if the outing file is from a PDR 
2.5 system. Overlay choices presented are determined by the vehicle type used to make the recording. 

 
Figure 17 – Single outing playback, circuit outing example, fastest lap is lap 2, lap 2 selected 

 

Lap Selection 

Single lap, multilap, or full outing playback is supported. Lap choice is made using the Explorer Bar. 
 

• Choose a single lap using mouse click – playback will be set to beginning of chosen lap, and extent 
of playback will be the single lap 

• By holding the Shift key, multiple, sequential laps can be selected for playback – the extent of 
playback will be the chosen laps 

• By holding the CMD button and clicking the mouse, a chosen lap adjacent to an already selected lap 
can be chosen 



 

15 
 

• CMD+click is similar to SHIFT+click but applies only to laps adjacent to each other whereas 
SHIFT+click can be used on a start lap and an end lap that are several laps apart, and the range of 
laps between start and end will be selected  

• Un-select all laps – whole outing playback mode (all laps including Out Lap and In Lap) 
 

 

Figure 18 – Explorer Bar, single outing, multiple laps selected using Shift-click or CMD-click 

 

Partial Region (Inlap/Outlap) Display 

By default, the lap selector will only show the timed, full laps for selection in the lap selector. Using the 
Options menu, it is possible to toggle the display to show the partial laps in addition. 
 
The Partial Regions are those where the timing does not include the full start line to finish line region: 

• For circuit outings – the inlap and outlap, or the partial laps where the lap timing was incomplete 
due to the vehicle stopping or going off track. 

• For autocross events – the staging and return to paddock regions 
 

 
Figure 19 - Control the display of inlap/outlap 
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Figure 20 - Circuit Outing showing Inlap/Outlap available for playback 

 
If you have Partial regions set to ‘On’ then these can also be chosen for playback  
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Playback Control 

Playback is controlled using the playback bar. A toggle button enables the adjustment of the displayed 
overlay. By default, for PDR 2.5 files, the overlay will be set according to the outing type opened: 
 

• Circuit outing - defaults to ‘Track’ overlay  
• Autocross outing - defaults to ‘Track’ overlay 
• Dashcam outing defaults to ‘None’ 

 
 

 
Figure 21 - Playback bar example, Sport overlay selected, audio set to 'on', lap time indicated on scrubber bar 

 

 
Figure 22 - Playback bar example, scrubber marker part way through lap, elapsed lap time shown, Track overlay selected, 

audio set to 'off', current elapsed time indicated 

For PDR1 and PDR 2 files, the overlays are not adjustable, and the button shows as ‘Static’ 

 
Figure 23 - Playback bar example, PDR1 or PDR2 file with Static overlays 

 
Playback of audio from the outing can be toggled on/off within the app. Volume control of the audio is 
handled by the device settings, not within the app. 
 

Menu Control of Playback 

 
Figure 24 - Playback control via the menu 

See section Error! Reference source not found. for details of the above Playback menu item shortcuts.  
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Dual Outing Playback 
With both a Current and a Reference outing opened (see section File Management and Outing Operations for 
instructions on how to open files), the outing videos are presented along with outing properties for both files 
(name, date, time, vehicle make/model,…), and a breakdown of the outings into laps. 

 
Figure 25 - Dual-video (comparison) playback mode (sidebar collapsed) 

If the outing file is from a PDR 2.5 system, the overlay toggle buttons can be used to switch overlays 
independently for each outing. If the outing file is from a PDR1 or PDR2 system, the overlay button is non-
active and displays ‘Static’ to indicate that the overlay cannot be changed. 
 

Lap Selection 

The Explorer Bar is used to select (via mouse click) a lap from the Current outing to be compared with a lap 
from the Reference outing. Refer to Explorer Bar description and use for instructions. 
 

Control of dual-outing playback 

The single Playback Bar is used to play back the two outings in a time-synchronized manner1. (The outings 
will both be played back at full speed; circuit location differences will be shown indicating how far ahead the 
driver was on one outing vs. the other. 
 
A time delta value is also added to the Current outing overlay to give a numeric value for the amount of time 
ahead/behind at any given point on the lap.  

 
1 Distance-based comparison is a feature being delivered in a later release 
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Export 
Outings from Enhanced PDR systems (PDR 2.5 outings) have dynamic overlays where the overlay data is held 
separately to the outing video/audio. This enables full control in the creation of videos for sharing with the 
overlay choice made at time of export, and not pre-set when the outing recording was captured.  
 
The export function is a key facility for Enhanced PDR users to create videos with visible telemetry data for 
sharing with others. 
 
Outings from PDR 1 and PDR 2 systems have static overlays. At the time of in-vehicle capture, the overlay 
chosen in the vehicle is embedded with the video and audio stream of the outing mp4 file. This means that 
the overlay cannot be adjusted with the AliveDrive Desktop application using the export function. The export 
of PDR1/PDR2 outings is still a useful function, however, as it enables a chosen lap or time-clip of the outing 
file to be created, meaning smaller files to share and quicker uploads to social sites. 

Export Initiation 

With an outing open for playback (or two outings if in dual video mode), an export function can be initiated 
from the menu. The export will always be of the Current outing (not the Reference). 

 
Figure 26 - Initiate Export via the menu 

If an outing has been under analysis in the application, and choices made as to lap and overlay choice, then 
these choices will be carried across to the export function to enable quick export of the part of the outing 
that was previously being analysed. The export function does however allow these defaults to be freely 
adjusted if required. 
 
Export setup and preview is provided via a pop-up window.  

  
Figure 27 - Export opens up in a separate window 
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Types of export 

Support for four types of export is provided: 
• Whole Outing export 
• Single Lap export 
• Multi-lap export 
• Time-based clip export 

 
Laps for export are selected with the mouse.  
A multi-lap choice (via CTRL+click or Shift+click) needs to be sequential laps. 
 
Choice of overlay is possible for PDR2.5 outing exports. 
 

Time-based clip export 

 
Figure 28 - Time-based clip export 

For scenarios where the user does not want to be constrained to laps for the export (for example a dashcam 
recording), a time-based clip export is possible. Full control of start and endpoints is possible either by 
manually entering digits into the start/end time areas or using the two scrubber-bar markers as shown in 
Figure 29 below. 
 

 
Figure 29 - Choose the start and end points  



 

21 
 

Export Preview 

The Export Preview panel within the Export window enables the user to see the chosen export settings, and 
an estimate of export file size. 
 
In addition, full and independent playback of the export is possible, without affecting the playback in the 
main application window. 
 
Note that if silent export preview is chosen (audio = OFF in the preview window), this will not affect the 
inclusion of audio within the exported file. Exported files will always include audio. 
 

Export Progress 

With the export setting choices made, the ‘Export’ button will initiate the process. 
 
The native file management application is then used to decide upon export location, and export filename. A 
default filename for the export is chosen, derived from the source outing name for clarity, but this name can 
be over-ridden. 

 
Figure 30 - Choosing location and filename for the export 

 

 
Figure 31 - Export Progress 

The application also has a built-in check for sufficient disk space and will provide warnings if the chosen 
location does not have sufficient space for the export. 
 
The export file is of MP4 format and includes the selected video/audio and chosen overlay data. The file can 
be played on all mainstream video player apps and is suitable for upload for sharing to social sites.  
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Software Updates and Stability 
A manual check for updates can be initiated. The current version can be found via the ‘Help’ menu item. The 
information regarding available app versions inclusive of release notes is available on the Cosworth website, 
on the AliveDrive Desktop product page. 
 
The app has built-in stability monitoring that constantly captures analytical data. This data is anonymised 
and is solely used to provide feedback to aid diagnostic analysis and bug fixes in the case of app crashes. In 
the situation where an app crash is experienced, the app will send the data to Cosworth with the ability for 
the user to add any additional notes to the report. 
 

Support 
For further assistance in using the application or the in-vehicle AliveDrive system, please refer to the 
Cosworth Support Forum: 
 
Customer Support 
 

https://www.cosworth.com/motorsport/products/alivedrive-desktop/
https://www.cosworth.com/motorsport/support/support-forum/

